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Welcome to the latest edition of my monthly Final Cut Pro newsletter -- and the last 
for 2005! 

The goal of this newsletter is to provide information helpful to the 
professional user of Final Cut Pro. This newsletter publishes each month. 
Past issues are not archived, however, key articles are posted to my 
website for your reference. All software references are to Final Cut Pro 5 
unless otherwise noted. 

Please invite your friends to visit my web site -- www.larryjordan.biz. We 
are working to make this a great Final Cut resource!
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"Discover the Power in Final Cut Pro" -- Tour Dates Announced!

Our recent "Supercharge Your Productivity Tour" was a wonderful success 
-- we had great turn-outs in virtually every city. Thanks for your interest!

Still, in reading over the attendee surveys, I realized that we needed to do 
more -- both for beginning editors and advanced editors. So, we've 
created a new tour with all new content! And this time, its traveling to 10 
cities throughout the US!

Seminar 1 - Supercharge your Editing with Final Cut Pro

Everything you need to know to get better organized, edit 
faster, and output better in one 4-hour session. If you are a 
self-taught or beginning Final Cut editor, or want a refresher 
course in power editing tools, this seminar is for you. 
$89 registration fee, $99 after 12/31/05.

Seminar 2 - The High-End of Final Cut Pro 5: HD, HDV, 24-frames 
and Soundtrack Pro. 

If you are an editor looking to jump into HD, or are currently 
drowning in HDV, this 8-hour seminar gives you the knowledge 
you need to make it work right. Plus, you'll get valuable, real-
world advice on what equipment to buy, or avoid. 
$199 registration fee, $225 after 12/31/05.

The tour starts January 18, 2006, and travels to:

●     Austin, TX
●     Chicago, IL
●     Los Angeles, CA



●     Minneapolis, MN
●     New York, NY
●     Nashville, TN
●     Orlando, FL
●     San Francisco, CA
●     Seattle, WA
●     Washington, DC

We are very excited about the tour -- with some very special partners and 
surprises that I can't tell you about until after the first of the year.

Register now -- seats are very limited in some cities.
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Technique: Replace Ambient Noise in Soundtrack Pro

During my recent seminar tour, I had a lot of fun showing how to take 
advantage of the audio clean-up power in Soundtrack Pro. (In fact, I've 
discovered even more power secrets, which I'll showcase in my next 
seminar series.)

Still, here's a good one to get you started. 

Many times, in editing, there's a problem with the audio, either a gap or a 
cough, or some other sound than what we want. It would be great if we 
could get rid of it. However, if we just kill the audio, the dead silence 
leaves a glaring gap that just seems to scream: "bad edit!!!"

Soundtrack Pro, which is bundled with Final Cut Studio, has a whole suite 
of audio clean-up utilities. In fact, there's one called "Replace with 
Ambient Noise" that's just perfect for solving this problem.

Here's how it works.



1. Open Soundtrack Pro. From the Browser tab in the Media windows on 
the left side of your monitor, navigate to the audio file you want to repair.

2. Double-click the file to open it into a new Audio Project. Soundtrack will 
ask to create a temporary file. Give it a name and location -- I tend to 
store these files in my FCP Projects folder, if I plan to reuse them, or on 
my second drive, if they are only temporary.



3. The file opens in the Project window. An Audio Project is always just 
one clip and only two tracks. Audio Projects are used to edit an audio clip. 
Multitrack projects are used for music and mixing.



4. Here's the problem -- there's a HUGE "uhhhh" in the middle of a great 
speech. (I've highlighted it here.) I need to replace it with some 
innocuous room tone; what Apple calls "ambience." However, the space 
just before it is filled with a giant, gasping breath. Sigh... I need to get rid 
of this, too.



5. However, at the very beginning of this clip, there's an itty, bitty space 
of perfect room tone. But it is far, far shorter than the space I need to fill. 
(It's highlighted here.) So, here's what we do. 



6. Highlight the room tone/ambience that you want to use, regardless of 
how long it is; however, longer passages are better than shorter ones. Go 
to Process > Set Ambient Noise Print. Soundtrack samples the 
selected noise and stores it in a special clipboard reserved for ambient 
noise samples.



7. Select the portion of the audio clip you want to replace with the clean 
ambience. Notice that here, the area to be replaced is far larger than the 
small sample we just took.



8. Go to Process > Replace with Ambient Noise. 



9. Voilá, all the bad sound is replaced by good sound! Soundtrack 
automatically looped and blended the sample to make is sound seamless.

This very cool technique can save your posterior when you are surrounded 
by stuttering idiots and you need to make them sound great!
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Soundtrack Pro Tips

Here are some quick Soundtrack tips:

1.  You can slip the audio in a Soundtrack clip by Option + Cmd + 
drag the clip.

2.  When you Send a clip to a Soundtrack Pro script, the actions will 



vary depending upon the length of the clip. For instance, if you 
create a two second fade up on a ten second clip, then Send a five 
second clip, the fade up will only take one second. This is similar to 
the way Final Cut scales keyframe locations by default in Paste 
Attributes. The only problem is, there's no way to turn this scaling 
off in Soundtrack.

3.  You can improve video playback by checking Preferences > Video 
Out > use quarter-sized frames to ON.

4.  Send a file to Soundtrack via a script creates a destructive edit. In 
other words, you are permanently changing the audio in your 
master media file.

I'll have more Soundtrack tips in future issues -- let me know if there's 
something specific you'd like to learn.
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Tascam FW-1082 follow-up

On our recent seminar tour, I brought along a Tascam FW-1082 mixer/
control surface to illustrate how to use the new control surface capabilities 
in both Final Cut Pro 5 and Soundtrack Pro. 

This mixer sparked a lot of interest and discussion. Derrell Newman 
attended our Atlanta Final Cut seminar and sent along additional 
information that I thought everyone would find interesting.

Derrell Newman writes:

Here's a follow-up to our discussion regarding the Tascam FW-
1082. This device, and others in it's category, are dual-
purpose components. They are (1) an Audio Interface for 
computer-based recording and (2) a post-production Control 
Surface for multi-track computer audio. 

As an Audio Interface, the device allows multiple inputs (mics, 
instruments, players, etc) to connect to a computer via 
firewire. The number of inputs is not only limited by the 



device, but by the software and the computer's capabilities. In 
theory, if the device has 10 inputs, and the software will 
address all of them, then a 10-track recording of audio could 
be created. Again, the computer must have a fast processor 
and enough RAM to support the load. 

As a Control Surface, the device (as demonstrated) provides 
the ability to adjust and keyframe multiple tracks in real time. 
I like this idea for a primary reason. The Audio Mixer in FCP4.5 
allows the same key-framing of mono or stereo pairs in real 
time, however, you are limited to one track at a time (with the 
mouse). Now, since most of us have ten fingers, the Control 
Surface will allow movement of multiple tracks simultaneously. 
To me, this enhances productivity by eliminating the need to 
repeat sequence audio and make adjustments track-by-track.

For Weddings and/or Music Video recordings, I'm considering 
the feasibility of using a Powerbook G5 with Soundtrack Pro to 
capture the live audio (roughly 4 to 8 tracks simultaneously), 
then in the Studio, import the mixed STP audio into the FCP 
project, sync the two, and poof, another masterpiece. Any 
thoughts on this?

Regarding [the brand of surface-controls], Tascam has been 
around for a long time, but I've always thought of them as 
high-end consumer grade, but low-end Pro grade (also they 
don't rate well in Customer Support). Personally, I like the 
Mackie products. Also, I've seen a few Mac studios that use the 
Digidesign 002.

These new audio features alone have me wanting to upgrade 
to FCP5 & STP. 

Larry replies: Derrell, thanks for the additional information.
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Commentary: Things About Soundtrack Pro that Drive Me Nuts!



When I first saw Soundtrack, I was blown away by some of power 
features, like audio repair and non-destructive editing. I'm still very 
impressed with it, now that I've spent time working with it.

But the more I got into it, the more I realized that there are some obvious 
missing features that absolutely drive me nuts. So I wanted to take a 
minute to sound off -- in hopes these can get fixed really, really soon.

Nuts factor 1: You can only load whole clips into Soundtrack Audio 
Projects. You can't select a clip range to process. Even when you send a 
clip from Final Cut to STP, the whole media file is imported, not just from 
the In to the Out in the sequence. Most of my captures are short, so I can 
work around this. But, if you traditionally capture whole hours at a time, 
this will drive you around the bend.

Nuts factor 2: Not one audio meter is labeled with a db scale. As far as I 
can tell, there are three different audio meters in Soundtrack. Not ONE 
has a db scale. This is RIDICULOUS! And you can quote me.



Nuts factor 3: Thinking quickly, I realized that there's a Multimeter filter, 
which has all kinds of great monitoring, and labels, built into it. However, 
the Multimeter is PRE-fader, which means that it shows the levels of your 
source audio, not the results of your mix.

Sigh... it would be nice to see what levels my audio is riding at. Nice, but 
currently impossible.

OK. I'm done now.
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This Month's Poll: What Features in Soundtrack Pro Appeal to You?

Notwithstanding my disenchantment with unlabeled audio meters, 
Soundtrack is still a great program. Not yet up to ProTools standards, but 
a significant powerhouse all on it's own.

I'm interested in learning what features in it appeal to you. So I've 
created this month's poll to find out.



All the features in the poll exist in the current version of the program. Pick 
your top three or four. As usual, I'll share the results next month.

You can view the results after you vote. The results of last month's poll 
are covered a little later in this issue.
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Get a FREE issue of Edit Well — the Newsletter for the Professional 
Editor 

I am pleased to announce Edit Well -- a printed newsletter for the 
professional Final Cut editor.

I love writing my free monthly newsletter and I am grateful for your 
comments and readership. However, the problem with writing a free 
newsletter is that I can't hire other writers to contribute their knowledge.

So, I created Edit Well -- a monthly, subscription-based newsletter filled 
with tips and techniques for the professional editor. Because it is subscription 
based, I can afford to hire some of the best Final Cut writers in the world. 

To launch this newsletter, I want to send you the Premiere issue -- 
TOTALLY FREE!

In it, you'll read Noah Kadner showing the best ways to work with 24-
frame video, Phil Hodgetts' article on creating LiveFonts, Kevin 
Monahan's extended article on creating powerhouse effects in FCP, Tom 
Wolsky with specific techniques to quickly move clips between Apple's 
professional applications, Bruce Nazarian on GPRM partitioning in DVD 
Studio Pro, plus, a new article from me, and dozens of tips, sidebars and 
other cool information.



24-pages printed in full color. This won't be available on my website, only 
by subscription. And best of all, you can keep all the back issues for instant reference! 

 

We will mail issues anywhere in the world -- so send Srithip your address.

And, for those who have asked, this free newsletter will continue after the 
Edit Well launch. However, it will change slightly in that we will introduce 
articles in Edit Well, then use this newsletter as a way to provide 
additional commentary and reader feedback.

Hurry, we are planning our press run now -- order your copy today!

[ Go to top ] 

Technique: How to Use Vertical Images in Video

by Wendell Davis

Wendell Davis sent me this article in response to last month's question 
from Michael Mulrooney. I thought he had some interesting thoughts, 
so I'm including it here to give you some fresh ideas on how to handle 
vertical images.

Suggestions on using vertical images in video: Reply to 
Michael Mulrooney's question.

Once upon a recent time I spent 14 years in a 7.5 year time 
period working for a museum. 98% of the paintings/portraits 
are vertical. So what do you do with them in a 4x3 or 16x9 
video format?

I did a lot of pulls, pushes, tilt ups and tilt downs in the video 
camera or on a motorized camera bed. BUT no matter how 



well you plan, I was never thrilled with the move, time 
duration, the feeling, you know just how it felt in the final edit. 
Then I started using Boris Red. (All this editing was done on an 
Avid MC 3D system... But now have gone to FCP5 and do 
everything in 16X9.)

Boris Red Process
I made two versions of each still image shot digitally on a 
Nikon D1X edited/adjusted in Photoshop. One in 72 dpi and 
the other in 300-dpi. WHY? The 72-dpi was used as place 
holder in the timeline- small easy for the system. The 300-dpi 
photo was used by Boris Red for the moves. The quality was/is 
fantastic… takes awhile to render I was even asked a number 
of times how it was done. Some photos where the moves 
lasted a long time I made the file size even larger... gave 
plenty of play-room. Later on depending on the need, and the 
project, I would do builds with multiple photos. 

Example
Take Michael's sports team. Make a photo build with the team 
over a photo of a wide sports scene background - the field for 
instance. The team sits on the right or left - possibly at an 
angle, the title is a lower third, then bring in each person's 
photo on the right and their name. You can do this in FCP, 
however the for me the fastest way is to do the build in 
Photoshop. 

1. Make the background setting - i.e.; the team & field. Save it 
as background. As a motorcycle safety advocate I’ll use some 
motorcycle stills from video as examples.

BACKGROUND SHOT



2. Size and place a team member’s photo in place. Save it with 
the background as team member 1, then 2, etc.... NO alpha 
channels needed.

 



3. Continue with each person, or start with the team and then 
add members.

 

4. Import all the stills into your edit system, place them on 
time line and dissolve between.

With a group added and person’s name:



The background is always the same, and all that appears to 
the eye is that the person and name are dissolving. Fancy it up 
by making two photos for each person, their photo and then 
their title, dissolve between them.

OR

5. Want to move the individual's picture in, keep the 
background in place and move each person in - fly, slide, wipe, 
etc... But you need to make the persons photo and title with 
an alpha channel.

Nice thing about doing it the Photoshop way, you can use 
guide lines to make all the heads the same size, easily add as 
much or as little drop shadow as you want, inner or outer 
glows, etc. Also makes it real simple for a dissolve. And you 
don’t have to worry about the alpha channels.

There are all kinds of variations but hopefully you get the idea.
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Tips from the Classroom

Here are two Final Cut tips from recent students regarding more ways you 
can use the Trim Edit window.

To open the Trim Edit window, double-click on any edit point. You can use 
the window to do real-time ripple or roll trims.

Matthew: I've discovered that you can set the In or the Out 
on the fly by pressing the "I" or "O" key.

Hugh: I've discovered that you can also set the In or the Out 
on the fly by pressing the Mark In or Mark Out buttons.

Larry: In a hurry to get the duration of a clip? Select the clip 
and type Control+D. The duration is displayed in the pop-up 
dialog box.
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The Missing QuickTime MPEG Encoder

I've gotten a lot of questions from folks asking what happened to the 
Quicktime MPEG encoder. So, here's the word from the Final Cut manual:

An MPEG-2 encoder doesn't come with the standard Quicktime 
installation of Final Cut Pro. If you have DVD Studio Pro or 
Compressor installed, an MPEG-2 encoder will appear in the list 
of QuickTime codecs when you export. You can also install and 
use a third-party MPEG-2 encoder. (page IV-225)

Tom Wolsky sent in an update to this statement:

This isn't right I don't think. If you install FCP you'll almost certainly install 
Compressor, but if you're running Tiger and QT7 an MPEG-2 export still does 
not appear in QuickTime Conversion. You really are required to use 



Compressor or third party MPEG-2 encoders that will appear there. 

Larry replies: Tom, you could be right. I only use Compressor to create my MPEG's, I just 
wanted to pass along what I read in the manual. 
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Technique: Converting a 16:9 sequence into a 4:3 video

This technique grew out of two simultaneous events: a request from a 
client and a letter from a reader. I'll let the letter set the stage.

Tom Porett, from the University of the Arts in Philadelphia, writes:

I enjoy your newsletter greatly - thanks very much. 

I have a question about converting a 16:9 format to 4:3 in 
letterbox
format (with bars). If there is an issue of the newsletter that 
has that
info I'd appreciate it.

I am uploading work to Google video and they require 4:3 
format only.

Larry replies: Yup, it can be done. In fact, I had a client this morning that 
needed to convert a DVCPro-50 16:9 sequence into a DV 4:3 video. 
Here's how to do it.

1) Open the sequence you want to convert into the Timeline.



 

2) Choose File > Export > Quicktime movie.

3) In the Save As dialog, change Current Settings to "DV NTSC 48K" -- 
if you are working with PAL video, you would select "DV PAL 48K". Then, 
make sure that Make movie self-contained. is CHECKED.

4) The movie will export -- and will take a while to do so, depending upon 
the length of the sequence you are exporting. Use this to rediscover the 
outdoors and sunshine. Look out a window, or something. 



5) When the export is complete, change your Easy Setup to "DV 
NTSC" (or "DV PAL" depending upon where in the world you live).

6) Create a new project and import your newly exported QuickTime 
movie. Then, edit it to the Timeline. 

Ta-DAH! Your 16:9 image format is retained, but Final Cut has now added 
black letter-boxing at the top and bottom of the image. You are now 
ready to output as a standard DV file.

The best part about this process is that no additional rendering is 
necessary; your file is ready to output as soon as you get it edited into a 
new sequence. 

Fast and easy.
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New XML2Text Version Announced

Andreas Kiel, the developer of the XML2Text utility for Final Cut, has 
announced a new version.

Andreas writes:

The new version is available as an early beta to all registered 
users.

If there are other people who are seriously interested in beta 
testing (and give some feedback), I'd love to include them.

Below is a brief description of the new version. The new 
features include:

Support for FCP5, XML version 1.0, XML version 1.x, XML 
version 2 compatible.

The application is still oriented to work with sequences, clips 
are a new feature.

Working with clips does allow to use the app as a logger for 
those "long" or "capture now" clips as well as long clips with 
many markers, like the documentary people love. You also can 
use the FCP "start/stop-markers" and use these to create 
subclips without the hassle of the FCP naming convention. 
Additionally those subclips can be saved to bins easily to make 
a project more clearly laid out.

Read/Write to the original XML

You can rename markers, clips, scene etc. more easily than in 
FCP. This sounds quite stupid or useless at the first glimpse, 
but makes life much easier if you want to clean up some stuff 
in a sequence - much less clicks.

Markers (with Read/Write to the original XML)

Can be added or removed, can be repositioned in any 

 



direction, can be changed in any way markers allow. This can 
be done with any selection of markers.

Markers are also a nice feature for spotting subtitles - you can 
add a basic subtitle to a clip as a marker in FCP. Now with 
every new version of your edit the "subtitle-marker" will stay 
at the right position of the clip, so they will stay at the right 
time within the sequence/timeline - if you're done, just export 
them as STL (or convert them from STL to FCP generators with 
TitleExchange).

Markers also can be imported from text files into the XML(FCP).

Filters (with Read/Write to the original XML)

Can be removed, disabled and hopefully added.

Can be "equalized", this means that all filter settings of a 
selected one are transfered to all filters with the same ID.

The final version will allow to scan for filter settings:

If a filter is found (only those which have an effect id) whose 
settings already occurred earlier, it wil be replaced with a 
reference to the first found filter with that settings. This allows 
to make variations of a sequence within a few seconds after 
the XML has been processed, since a value always only has to 
be changed at occurrence 1.

Find

Allows to find markers or clips based on their "sub-values" like 
in, out, name, comment, scene, take etc. and to modify many 
of the values of the markers/clips (or to modify the text export)

The find command also can be used in several steps, so you 
can do a search in the complete database first and than in the 
found results and than … refine your search.

Quick Tools



•  Allow to fill up gaps in video track 1 with slugs, this does 
make EDLs more compatible with other systems

•  Disable all filters, this creates a version of a sequence XML 
where all filters are disabled - so just a preview of the cut 
without any need to render

• Clear empty tracks, this does remove all empty tracks in any 
XML (project, bin, sequence, clip)

•  Enable all clips - I often use the disable clip, so I don't loose 
the rendering file, or I do use it for title generators, but with 
long programs it sometimes happens I forget some to enable 
again.

•  Remove empty tracks (in every kind of FCP XML)

•  Maybe hopefully - this is my favorite - un-nest sequences for 
final output! All this film guys - like me - would be happy, if 
that would work to an unlimited amount of levels of nested 
items. Currently it works fine for 1 level.

Import Text

You can import tab delimited text or chapter lists into the XML 
as sequence marker.

Tree Viewer

You can import any kind of FCP XML and the "Tree Viewer" will 
show you the structure. Even though this could take a while, 
this feature can be quite handy, if want to take out a part of 
this XML to edit it with XML2Text without reopen FCP (or not 
having FCP at all on your machine).

Hope this gave you a better survey of what will happen with 
the next version.

Larry replies: You can learn more about this utility, or contact Andreas, 
at: http://www.spherico.com.

http://www.spherico.com/filmtools/
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Last Month's Poll

Last month's poll asked how long you had been editing.

As expected, there were a whole range of answers, but exactly half (50%) 
of the readers that answered the survey have been editing for seven 
years or less. And almost two-thirds have been editing for less time than 
computerized editing has been around.

Interesting. 

Plus, a tip of my hat to all 14 of those editors who have been editing 



"since the beginning of time." I can identify with that...
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Larry's Final Cut Pro 5 Book Makes 
Amazon's Top 100 Computer Books List!

In a shameless plug to get you to buy my Final Cut Pro 5 book for all your 
friends and relatives for Christmas, I got an email from my publishers, 
PeachPit Press and Lynda.com, that my book, Hands-On Training for Final 
Cut Pro 5, made Amazon's Top 100 computer books list over Thanksgiving 
Weekend.

Wow! With over 800 bajillion books on Amazon.com, I was really 
impressed!

However, if you don't yet have your very own copy, now's the time to 
hustle over to our store and stock up.

Here's what's available:

Books

●     Hands-on Training for Final Cut Pro 5 
●     Hands-on Training for Final Cut Pro HD

DVDs - Narrated Quicktime Training

●     Final Cut Pro 5 - Essential Editing
●     Final Cut Pro 5 - Essential Effects
●     Final Cut Pro 5 - Beyond the Basics (ships 12/10)
●     Learning DVD Studio Pro 3
●     Principles of Digital Video
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http://www.larryjordan.biz/store/index.html
http://www.larryjordan.biz/store/index.html
http://www.larryjordan.biz/store/index.html
http://www.larryjordan.biz/store/index.html
http://www.larryjordan.biz/store/index.html
http://www.larryjordan.biz/store/index.html
http://www.larryjordan.biz/store/index.html


Technique: Converting HDV for DVD

by Bill Koepnick

Bill Koepnick sent in this great technique to answer questions about how 
to get HDV into your DVD. Bill writes:

I purchased a Sony HDR-FX1 shortly after they hit the stores hoping to 
shoot HDV and simply down-convert to SD for DVD distribution until a HD 
DVD format became available. Final Cut 4 wasn't yet ready for HDV, so I 
used the camera to perform the down-conversion to SD DV, and had no 
problems using a standard DV workflow. The HDV tapes went back on the 
shelf. I had read about the alternate methods of using Lumiere and other 
codecs to allow use of HDV, but they all seemed too complex and more 
hardware intensive than my equipment could comfortably handle.

Months passed. I made the upgrade to the Final Cut Studio bundle as 
soon as it became available, and was not disappointed in the HDV 
implementation. With a 2GHz dual-processor G5, 1.5 GB of RAM, and two 
internal 250GB SATA drives I had no trouble making the HDV projects 
work nearly as smoothly as the DV jobs. Rendering was considerably 
slower, but the increased pixel count made that pretty obvious.

The big snag finally hit when I wanted to down-convert a finished HDV 
project to and burn a SD DVD. The discussion boards were full of people 
crying the same sad song - there apparently were NO good options for 
this. Apple certainly didn't offer any helpful workflow suggestions despite 
touting the possibility. I spent endless hours trying to get a satisfactory 
conversion in Compressor, Quicktime, iDVD, and DVD SP with consistently 
dismal results - or impossibly long conversion times. The only sane option 
was to use Print to Video back to the FX1 in HDV, and then re-capture the 
sequence into a SD DV project. 

After finishing a wedding video with roughly an hour's worth of final 
footage, I again tried to find a better way, and FINALLY came across the 
magic combination of settings in Compressor 2 that will yield better 
results than a round-trip to the camera and back to FCP. 

I shot all the footage in HDV on a pair FX1s. All footage was captured into 
FCP5 using the Easy Setups for HDV in the Capture, Sequence, Device 



Control, and A/V Device Presets. I did use a Kona 2 card to view 16:9 
output while editing, but other than a color correction reference it doesn't 
affect the process. All the stock settings - no tricks here.

After finishing the edit, I output the five individual sequences I created by 
doing an Export to Quicktime. The settings in the Export dialog were... 
Setting: Current Settings, Include: Audio and Video, Markers: Chapter 
(because I had set some Chapter Markers), Recompress All Frames was 
NOT checked, and Make Movie Self-Contained WAS checked. Since the 
sequences had all been fully rendered the Export was not terribly long - a 
bit less than running time.

The big step is encoding in Compressor, and where I discovered the key 
to this process. I dragged the Self-Contained Quicktime movies into the 
Batch window and assigned the conversion Setting to DVD Best Quality 90 
min 16:9. The stock setting will NOT perform well, however, because the 
Field Dominance defaults to Top First - which results in horrible motion 
displacement. The Automatic setting fails to set Field Dominance correctly 
as well - you must select the conversion setting and use the Video Format 
Tab in the Inspector to MANUALLY SET FIELD DOMINANCE TO "BOTTOM 
FIRST". The remainder of the default settings will result in a final m2v that 
is visibly superior to the round-trip to the FX1 for conversion. If you have 
the time to spare, you can try to increase some of the default Quality 
settings in the Inspector, but get ready for some absurd render times (like 
weeks!). The hour's worth of footage I submitted to the Batch took over 
22 hours to encode, but the result is a cleaner picture (fewer blocky 
compression artifacts) and less wear and tear on the FX1. You do need an 
accommodating deadline and patience.

So -- that's my tale. I am just so relieved to have finally gotten this to 
work that I couldn't help but share the revelation. Perhaps the more 
seasoned Video Pros know all about this process, but I hadn't found 
anyone who had taken the time to document it. I still want a way to 
preserve all the clarity of the HDV master, and hope that the High-
Definition DVD wars are settled VERY soon. 

Larry replies: Thanks, Bill, for a very helpful technique.

[ Go to top ] 



Technique: Examining the View Menu Playback Controls

I've seen a lot of confusion about how the View menu playback controls 
work, so I wanted to take a few minutes and explain them so you have a 
better understanding of your playback options.

View > External Video

 

This tells FCP whether you want it to feed video to an external 
device like a camera, deck or monitor. If you don't have 
capture card, camera, or deck attached to your computer (or it 
isn't turned on) set this to Off. However, it MUST be ON if you 
want to feed video to an external device. This includes Printing 
to Video and Editing to Tape.

View > Refresh A/V Devices

 

If you turn on your camera or deck after Final Cut starts, you 
need to tell FCP that a device has been added. FCP then polls 
your Firewire ports to figure out what you've done and say 
hello to it. While it is often easier to turn on a Firewire camera 
or deck before starting FCP, it isn't necessary. However, what 
IS necessary is refreshing your devices -- telling FCP to check 
its ports -- if you turn a device on after FCP is already running.

View > Video Playback



 

This tells FCP what kind of device you have attached. If no 
deck is selected, use Digital Cinema Desktop Preview. This 
turns your computer monitor into a video monitor. To watch 
videos full-screen, press Cmd+F12. To exit back to FCP, press 
ESC.

View > Audio Playback

 

This tells FCP where to play audio. It is CRITICAL that you 
monitor audio and video at the same point. If you are watching 
video on a FireWire device, you must listen to audio on the 
same device. Watching video on a video monitor while 
listening to audio coming from your computer is a recipe for 
disaster -- because there's a built-in 3-9 frame delay in 
sending signals to a FireWire device. This means that things 
will sound out of sync, when they really aren't. 

However, Tom Wolsky reminds me that: "There is a playback 
offset to match the computer audio with a delay to the digital/
analog conversion path. This does add a delay in the response 
time for playback start/stop."



 

You can find it in Final Cut Pro > System Settings > 
Playback control tab, by adjusting the Frame Offset. The 
default setting is 4.

To prevent driving yourself to distraction, make sure audio follows video 
and that you are always watching and listening at the same place.

My procedure, when turning on a deck, is to:
1) Refresh A/V devices
2) Set View > External Video to ON
3) Set Video Playback to NTSC Firewire
4) Set Audio Playback to Audio follows video
5) Then, open the Log and capture window to make sure the VTR OK 
message appears. 

When that process is complete, I'm good to go.

[ Go to top ] 

Reader mail

Still frames don't match video 



Mike Krause, over at Technicolor Creative Services, writes:

Here's the sitch: 

FCP 4.5, QT6, Kona board, using Blackmagic 10 bit codec, 
timeline renders in RGB. From digitized SD video, using 
Quicktime conversion export an uncompressed TIFF. Import 
that static back into the project, it matches the video it was 
exported from.

FCP 5, QT7, tried Kona, Kona2 and Decklink boards, tried 
Blackmagic 10 bit, Blackmagic 10 bit RGB and Uncompressed 
10 bit codecs. Tried timeline renders in both RGB and YUV. 
Again, from digitized SD video, using QT conversion export an 
uncompressed TIFF. Import that static back into project - 
matches, right?

On two of our FCP 5 systems, the static and the video match, 
but only within the system the static was exported from. When 
checked on another system the static and video don't match. 
On the third system, the static and video don't match at all.

Well, when that static is imported into our FCP 4.5 system, it 
does NOT match, no matter what. On the static, the black 
levels tend to be quite a bit higher (about 50mv) than the 
video. 

For our workflow, it is essential that these frame exports 
match the video. We've been forced to roll back to FCP 4.5 for 
the time being, and our two largest clients have asked their 
vendors all to roll back to FCP 4.5 until this issue gets sorted 
out - so it's more than just us having this problem. 

I know there are YUV vs RGB issues going on, but we can't 
quite nail down where the issue is - QT 7 or the Blackmagic 
codecs in FCP5 seem the most likely candidates, at least from 
the tests we've been doing.

[In a second email, Mike provides additional follow-up.]



Well... seems to be a Quicktime 7 issue. Apple released a 
rollback to QT 7.0.1 not long after issuing the 7.0.3 update (for 
ipod video security), but we continue to have the same issues 
with exported stills not matching up to the video it was pulled 
from regardless of which QT 7.x.x we use. Again, we've tried 
multiple codecs, effects handling codecs, rendering (YUV, RGB, 
etc) and cards (Kona, Kona 2, and Decklink) all with similar 
results.

I hear down the grapevine that other users have been 
reporting to Apple similar issues using FCP5 and QT7; I haven't 
yet heard of any resolution.

I've started researching this from a different angle, looking to 
how Photoshop handles gamma correction between RGB and 
YUV sources. If I can at least come up with a script-able 
Photoshop action to correct the exported statics, we could use 
the improved functionality of FCP 5 with a workaround in 
Photoshop until Apple issues a fix for QT 7. Unfortunately, it's 
not as simple as just going into the gamma correction tools in 
Photoshop and adjusting (0 to 255) to (16 to 235) or vice 
versa, otherwise we'd be set. There seems to be something 
else going on with the Quicktime conversion export process - 
not just affecting the gamma / color space. 

Larry replies: Mike, I don't have an answer, but let me send this out to 
everyone and see if someone else can give us some guidance. The stills 
SHOULD match. I'm interested to learn why they don't.

- - -

Improving FCP OMF Export

José Luis Diaz, from Argentina, writes:

I’m not an image editor, neither a FCP user. I’m a sound editor 
that co-owns a small post production company in Argentina, 
mainly devoted to feature film (but also to TV episodes and 
commercials). You can see our web page at: http://www.
abbate-diaz.com.ar

http://www.abbate-diaz.com.ar/
http://www.abbate-diaz.com.ar/


So, being a sound person, why I was interested in reading a 
newsletter about FCP?

Because we receive many, many projects edited in FCP (as 
time pass, more and more) and because, some times, the 
image editor lacks knowledge about how to interact with us.

In the case of Avid editors, we developed a technique in which 
we export OMF Embedded production sound to them and after 
they're done editing they export OMF Composition Only. Then 
we relink their edit decisions in our audio workstations. We are 
very happy with this method.

But as you know, FCP doesn't support OMF import (Embedded 
or Composition Only) or, for export, OMF Composition Only.

Automatic Duck’s Pro Export FCP only exports Embedded not 
Composition Only.

Automatic Duck’s Pro Import FCP doesn’t support OMFs 
generated in Digidesign’s ProTools (our DAWs).

Gallery’s XMLPro export and XML file but it's workflow is very, 
very restricted. 

It is thought for very big Hollywood size production where 
original sound production is recorded on Deva, Cantar, etc. In 
my country that task is still done on DAT’s.

So, when a project is edited in FCP, we are working in ways we 
don’t like.

Maybe, you have some influence over Apple or other 
developers related with FCP. If this is the case, could you, 
please, make the suggestion to make FCP imports OMF 
Embedded sound and export OMF Composition Only?

Thanks, Larry and congratulations about your Newsletter. 
While I’m a sound person it interests me a lot.



Larry replies: Thanks for writing. These seem to be good ideas, and I'm 
happy to pass them along.

- - -

Thinking about the competition

Dilesh Korya, from the UK, writes:

Just a quick note, you may be interested. The BBC have made 
changes in their Features and Documentary Section (making 
non-natural history documentaries) are now moving over to 
using FCP and ditching AVID. All other departments are 
switching to 50% AVID, 50% FCP. Big changes, huh? 

Some of us here in Bristol, where I am based, have been 
disappointed with the last release of FCP and Tiger. I think we 
need AVID to keep Apple on its toes and give us the 
developments we want.

Larry replies: I truly believe competition is a good thing... um, as long as 
they are competing with someone other than me. Thanks for your 
comments!

- - -

Killing the Jaggies

Rich writes:

Just a question about the basic 3d filter in FCP.... When we use 
the basic 3d filter in perspective tab we get anti-alised lines on 
the edges of the picture. We can clean it up a little by adding a 
black border but if the picture is over anything other than 
black then the that wont work... any ideas, or is that all you 
get with this effect.... remember I am rotating the image on 
the Y axis and thats when you see the jaggies.

Larry replies: Some jaggies are inevitable on any slanted line due to the 
low-resolution nature of video, compounded by interlacing.



 

Here's an example of bars rotated on the Y and Z axis. (And I have NO 
idea why this image seems to turn a corner, but it does.) Notice the 
jaggies along the diagonal lines. Much of this is due to the nature of video, 
made worse by selecting an angle that exaggerates the jaggedness.

However, for something that may help, be sure that in the Sequence > 
Settings > Video Processing tab Motion Filtering Quality is set to High. 
(This feature is only in FCP 5.) That may make a difference in your final 
render quality. This setting ONLY affects rotation and scaling, but it's still 
worth trying.

- - -

Editing in HDV

Wendell Davis writes:

Larry: I look forward to your new Edit Well publication. Shifting 
from AVID to FCP5 - still not used to it. I could edit much 
faster on the AVID but there are more interesting things to try 
on FCP. Also spent a fortune on AVID. Since I only work for 
non-profits and receive little or no money from them, FCP is 
more affordable. FYI now shoot ONLY in HDV Sony. Even for 
my granddaughter... Found no problem editing in Apple HDV 



going through Compressor to DVD SD.

Larry replies: Thanks for your comment. Clearly, there is value in shooting 
HDV -- the key is to know its strengths and weaknesses, then select it 
when it can help you get your job done.

- - -

Creating great looking slates

Steve Smith writes:

Got a question for you. I edit in an office where I need to make 
slates for SMT's & VNR's, feeds etc. "QUICKLY" and the 
limitations of the FCP text editor drive me crazy!!! 

Is there any way to be able to use multiple fonts and sizes in 
"one" text layer? The other NLE's I've used always had this 
ability but FCP doesn't.

Larry replies: No and yes. The text clips in FCP only allow a single font at 
a single size in a single color. However, the Boris titler allows multiple 
fonts, sizes and colors. Versions of this software have been bundled with 
FCP since version 2 - as Tom Wolsky and othesr have reminded me. You 
can find it at the bottom of the Generator tab in the Viewer -- the little 
pop-up menu in the lower right corner with the letter A.

You can also create your slates in PhotoShop and import them into FCP. 
Remember to create all single layer graphics at 720 x 540 x 72 prior to 
importing.

- - -

Getting the Shimmer Out

Billy Miller writes:

I emailed you before about image size for panning an imported 
photo. Much to my astonishment you responded in your 
September newsletter -- 1800 x 1350 pixels. :) 



Now I'm curious about getting rid of the shimmering effect 
when zooming in or out with this larger image.

I add .5 gaussian blur which works great close up but when I 
zoom out I get the shimmer. If I add, say, 2.0 gaussian blur 
the image looks bad up close.

Any thoughts?

Larry replies: Try key-framing your blur so that the blur decreases as you 
zoom into the image. Or, in FCP 5, change the video render settings to 
Best (Sequence > Settings > Video processing tab).

- - -

Where's the money?

Eddie Young writes:

My partner and I have started a multi media and animation 
company. (I've been an illustrator for 21 years and I've had to 
branch out in an effort to stay afloat during the Bush years)

We've got several video production jobs under our belt now, 
but bidding jobs is still a mystery. Do you know of a "pricing 
guideline" for video production that covers day rates for 
camera work, editing, DVD production etc.?

Walter Schupp continues along the same lines:

The results of your last poll were very interesting, but what I 
really want to know is how much are people charging per hour 
for an FCP edit suite. I know it will depend on whether it is a 
DV only system or an HD system. Maybe that could be part of 
the poll. I’d love to see sample rates for DV only, Betacam/
Digibeta, and HD suites. If you want to go a step further, you 
could ask if people charge different rates for digitizing, motion 
graphics, and audio sweetening using the same room and 
system.



Larry replies: These are great questions, but almost impossible to answer. 
My newsletter is read around the world, so when it comes to pricing, 
answers vary widely due to currency differences, variations in income by 
country, as well as the skills of each individual editor.

For the same reason, trying to determine a common pricing pattern for 
post-production is a major challenge for publications with much larger 
budgets who are focused on just a local region.

As a work-around, do what everyone else does - pose as a customer and 
contact your competition; or post-production facilities in a nearby city. 
Ask to see their rate card. After calling a few places, you'll start to see 
where prices group, so you can decide where to set your own prices.

And, after all, when you think about it, that's just what your customers 
are likely to do, too. They'll call a few vendors and go with the one that 
provides the best service for the best price. Mostly.

- - -

Running FCP HD on a PowerMac G-5 Quad

Mark Joseph writes:

Following up on the question about running FCP HD on a new 
Quad G-5, it may be possible to run the FCP 4 on the new PCI 
Express G5, here are two methods users have pointed to:

Control+Click on the Final Cut Pro application and select 
show package contents. 
Open the contents folder and open info.plist. 
Search for AGP replace it with PCI. 
Save and close the file. 
Open FCP4, and voilá it works. 

Another method as used to unofficially install on G3s:



http://www.xlr8yourmac.com/feedback/
final_cut_pro_on_old_macs.html

Larry replies: Mark, thanks for the info. Please remember that changing 
the package contents of Final Cut can create serious problems. Do this 
ONLY if you can remember how to restore everything the way it was, in 
case things don't work as you expect.

- - -

Looking for an SDI DV deck

Gene Lebrock writes:

Enjoy your newsletter and have a question for you. I'm in the 
process of buying a pro dv deck and I need SDI capability. I'm 
looking at the DSR 1600a... do have any thoughts on this deck 
or other suggestions?

Larry replies: I have several clients who use the DSR-1600 deck. While 
I've only used it when I'm working on their systems, it seems to work 
well. If any readers have other recommendations, send them in. I'm 
happy to pass them along.

- - -

Working with reference movies, part 1

John Warner, from Asheville, NC, writes:

First, thanks for a great seminar in Atlanta, I really enjoyed it!

Second, I'm trying to follow your advice to create a reference 
QuickTime movie when exporting a project from Final Cut to 
convert into a DVD.

What happens, however, when the real footage which those 
reference movies point to gets deleted? The reference movie is 
no longer valid, correct, since the actual movies and rendered 

http://www.xlr8yourmac.com/feedback/final_cut_pro_on_old_macs.html
http://www.xlr8yourmac.com/feedback/final_cut_pro_on_old_macs.html


sequences have been deleted?

I understand that one should not delete their FCP files until 
after the DVD has been created and completed. So assume 
that I follow the workflow of: 1.) FCP full edit and export 
reference movie. 2.) Create DVD using that reference movie. 
3.) Deliver DVD which client O.K.'s. 4.) Archive FCP project 
folder and delete that project's capture and render folders. 5.) 
Archive the DVD with the menus, tracks and slides folders.

What happens several months later when the same client 
wants some tweaks to the DVD? Wouldn't I have to first reload 
the FCP project (from my backup DVD-RAM), re render all 
sequences then export a sequence file just to get the archived 
DVD project to work correctly?

Sorry to be so dense on this but I am actually making some 
drastic changes to my workflow because of your fine workshop 
and I wish to get it right.

Larry replies: John, you are correct. A reference movie points to the 
source media files which are stored on your system. If those files get 
deleted, then the reference movie won't play.

However, a reference movie does NOT point to any Final Cut project files, 
only to the media, or render files. So, if a client needs tweaks to an edit, 
you would need to go back into Final Cut and reedit to make the changes, 
then output a new reference movie to burn to a DVD. If they need tweaks 
to the DVD, that don't involve reediting the video, then you would need 
access to your DVD project files and it's associated media files.

- - -

Working with reference movies, part 2

Following up on this reference movie discussion, Ryan Downer writes:

I use FCP 5 and Compressor 2 all up to date on 10.4.3. I shoot 
DV with a PD150 NTSC and my end products are DVDs. My 
question is two-fold. First, if I export a same-as-timeline, not 



self contained QT file for Compressor am I going to get the 
same results if I had just exported to compressor from FCP? I 
know the latter choice takes about 300 times longer. 
(example: 12 min timeline took about 8 hours and with a QT 
export about 1 hour). So will my results be the same?

Secondly. I understand with DVD-R you shouldn't go over a 
7.3 as a max bit rate while using AC3 audio, right? So with a 
12 min timeline or a 40 min timeline will I be using the same 
exact bit rates (example: 6.3 min bit rate and a 7.3 max bit 
rate)???? Can I ever go over 7.3 and be safe with all DVD 
players? ON THE OTHER HAND, would a pressed DVD from a 
glass master differ? Could I go over a 7.3 max bit rate using 
that kind of media? Or is it simply a DVD streaming issue?

I do a bunch of shorter videos. Where can I find settings for 
these lengths? Or what sort of equation can I use...? 
Pondering. I just feel I use the 6.3 and 7.3 bit rate setting for 
everything and I feel that is wrong....

I REALLY appreciate your input. Thanks.

Larry replies: Ryan, my favorite way to get a movie out of Final Cut into 
Compressor is to export it as a reference movie (File > Export > 
QuickTime movie -- with "Make Self-Contained Movie" NOT checked.)

Then, drag it into Compressor and process as normal. The image quality 
will be the same. I've discovered that whether you export to Compressor 
or as a QuickTime movie, all the compression markers that Final Cut 
inserts are in both versions.

My recommendation is to set the average data rate to 5.5 and the max 
data rate to 7.2 -- regardless of whether you are burning or replicating (i.
e. going to a glass master). There's no advantage to going much higher 
and there are significant problems with data rates that are too high.

- - -

Problems with Speed-Changed Clips



Tim Wilson writes:

I've noticed a problem when, using Media Manager to save a 
trimmed project and delete unused media, I open the new 
(copied and archived) project file. Any clips in the new 
project's timeline that are not normal speed (i.e. 100%) come 
out erratically, usually too fast. I have taken to re-marking the 
clips, re-setting the desired (usually slomo) speed, and re-
assigning them to the timeline. Is there a quicker way around 
this? And has this problem been addressed in FCP version 5?

Larry replies: Media Manager has problems with speed-changed clips to 
the point where it drives all of us nuts. Your workaround is as good as 
any. And, no, this has not been fixed in FCP 5.

- - -

Problems with Scrolling

Not daunted by getting this first answer, Tim tried again:

May I push my luck and ask you one more thing that I've not 
been able to find an answer to, either in your book or in FCP's 
manual? (I was going to put this to Uli Plank, a friendly name 
that I notice has cropped up on your list). I am trying to do a 
relatively simple scrolling end-title sequence for a project. I 
want the titles to scroll from bottom up, but stop before the 
title has completely rolled off the top of the screen. It's not a 
question of masking, but of stopping, the scroll, before the 
time indicated for end of the titling clip.

I've tried locating the point where the final screen is as I want 
it -- last line of credit at the bottom, not top, of the screen, 
marking that, finding the same frame in the viewer and trying 
to make that a freeze-frame. No dice. I've also tried double-
clicking on the rolling text clip in the timeline, then inserting 
motion keyframes at that point for "center" and "anchor point", 
but this, too, fails to stop the continued scrolling upwards.

Larry replies: Sigh... two for two. There is no way, without first exporting 



the text clip to convert it to video, to pause or stop scrolling text inside 
FCP. 

Except... Chi-Ho Lee writes in with the following update

If you use Boris Title Crawl, you can achieve what he wants to 
do - stopping a scrolling in it's motion.  You have to check the 
"Use Percentage Completion" box and then keyframe the 
"percentage complete" parameter.  This will allow you to 
manually keyframe how the Roll will move from the bottom to 
the top or vice versa.

This is a little known secret!

Then, Grant Benatar wrote in with another solution:

I create all of my scrolls and rolls in Photoshop then import 
them as still images into FCP. I can then key frame the motion 
any way I want! All you have to do is increase the verticle size 
of the image in photoshop to suit your needs. It can 
sometimes take some tinkering, but it has never failed me.

- - -

Moving Markers

Markus Wernig writes:

Is there any way you can think of that would allow us to 
transfer markers from one master clip to an identical second 
one?

This came up in our company since many editors like to use 
markers on long master clips. When these master clips get 
corrupted (as 2 did in our case), you can simply reimport the 
clip, but you lose all markers. We are a movie trailer shop and 
work with full-length features which are usually captured in 2 
one-hour clips. Losing markers can be a big deal for us.

Larry replies: Nope. Since you can't select markers, there's no way to 



copy or move them.

- - -

Issues on Archiving to Tape

Greg Kolar writes to re-ignite an old debate:

I use miniDV. When I first started archiving weddings on 
miniDV tape, I was giddy with expectations of wonderful digital 
footage maintains for years to come. In less than 6 months, 
the tapes had audio drop-outs bursting my bubble.

I only like the idea of archiving weddings on hard drives 
because it removes the fear of miniDVs gone bad. As 
wonderful a camera the PD-150 is, I can say that mini-DV 
tapes are a BIG disappointment to me.

Larry replies: I understand your frustration -- dropouts are not good. 
However, I am DEFINITELY not a fan of archiving on hard disk. 
Technology goes out of style every four years. Suddenly, cables, 
connectors, or drivers don't work with new computer gear. You have a 
perfectly fine hard disk and no way to connect it. It can't be accessed, or 
the OS changed. Using a hard disk for short- to medium-term archiving is 
fine. But anything longer than a couple of years, I believe, your best 
media is tape. 

Always make sure you are buying the highest quality tape stock from a 
reputable manufacturer.

- - -

Wrap-up

Well, that's it for another issue. Thanks for your time and attention.

A few last-minute reminders:



2) Please visit our store and buy something. Christmas is 
coming and my cat wants a present.

As always, let me know what you think about this issue and tell your 
friends to subscribe. I love reading your questions and comments and 
sharing them with others. 

Or, even better, send in some tips of your own. I'm happy to publish 
everyone's ideas. That way, we all learn!

Thanks -- and edit well!

Larry

Subscribe to Larry's FREE Monthly 

Final Cut Pro Newsletter!

Email:    
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The information in this newsletter is believed to be accurate at the time of publication. However, 
due to the variety of possible system and software configurations, the author assumes no 
liability in case things go wrong. Please use your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter has not 
been reviewed or sanctioned by Apple or any other third party. All trademarks are the property 
of their respective owners and are mentioned here for editorial purposes only.

Text copyright 2005 by Larry Jordan. All rights reserved. This newsletter may not be reproduced 
or published in any way, in whole or in part, without specific written permission from the author. 
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